Entertainment

To delete playlists
» Entertainment » Media Player select a playlist
» More » Delete Playlist.

Music and video clips

To play music and videos

» Entertainment » Media Player and select a playlist
» Open » Play. The playlist keeps on playing until
you » Pause or Stop.

To change play mode

» Entertainment » Media Player » More » Play
Mode. Select Shuffle On to play the playlist files in
random order, or Loop On to restart the playlist
when the last file has been played.

- You can also change the play mode from within the
playlists.

Media player control

+ » Pause to pause the playback.

* Press @ or €g) to go forward or back to the next
music track or video clip.

* Press and hold @ or ) to fast forward or
rewind.
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* Press ) and @) to scroll through the playlist
during playback. Files that are highlighted will
not be selected until you press » Stop » Play.

» When a video clip is paused, press Q) to play
the video clip one frame at a time.

Media player options

» More to view the following options:

» Play Mode — change the playback order of songs
and videos. Select Loop or Shuffle.

» Equalizer — change the settings of the treble and
bass when playing music.

* Rename — rename the playlist. You can only
rename user-created playlists.

» Delete Playlist — delete the playlist. Only the
playlist is deleted; the files are still listed in the
My Stuff. You can only delete user-created
playlists.

Media options

When you have opened a playlist, » More to view

the following options:

* Information — view information about the current
track or video.

» Add Media — add files or folders to the playlist.

* Minimize — minimize the media player and return
to standby. The music continues to play and you
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can use other applications and functions in the
phone.

« Play Mode — change the playback order of songs
and videos.

» Equalizer — change the settings of the treble and
bass when playing music.

» Sort —sort the playlist by artist, title or by the
order in which files were added to the playlist.

» Send — send a sound or video file.

* Delete — remove the file from the playlist.

 Capture Frame — capture a picture from the video
clip.

Online music and videos

You can view videos and listen to music that you
find on a Web site by streaming them to your
phone. When browsing and when you have found a
link for streaming, the media player will open
automatically when the link is selected.

In order to stream you must have a data account.
Your phone may be pre-configured with a data
account. If it is not, please contact Cingular or visit
www.SonyEricsson.com/support W 68 Settings.
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To select a data account

1 » Settings » Connectivity tab » Streaming
Settings.

2 Select the data account you want to use.

To stream video and audio
1 » My Stuff » Videos » More Videos.

2 Follow the instructions to stream.

To stream saved music and videos

1 » Cingular Mall » More » Bookmarks.

2 Select a link to stream. The media player will
open and play the streamed music or video.

Hit Picks

This function is network- or operator-dependent.
Please contact Cingular for information about your
subscription and Hit Picks. In some countries you may
be able to purchase music tones from some of the
world s top musical artists.

With the Hit Picks service, you can listen to music
tones before you decide to purchase and download
them to your phone. Each music tone is part of an

original song and is optimized for your

Sony Ericsson mobile phone.
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Before you start

First make sure that:

* You have a phone subscription that supports
GPRS data transmission.

* You have entered the correct settings in your
phone, W 68 Settings.

* You may also have to register as a WAP user
with your service provider or network operator.

* You have free memory in your phone.

Accessing the Hit Picks music tone
list

By selecting the Hit Picks icon, you download the
Hit Picks music tone list to your phone. You can
now listen to a music tone in the list.

To listen to a music tone
Cingular Mall » Hit Picks and select a music tone
that you want to listen to.

Downloading a music tone from the
Hit Picks list

The total price for the download is the price
appearing on the screen when you select to
download and save a music tone. Your phone bill
or prepay phone card will be charged by your
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network operator after you have purchased the
tone.

To download a music tone

1 When you have listened to a music tone that
you want to download, first verify the purchase
details above, then read the terms and
conditions provided in the phone kit. By
agreeing to purchase in the phone, you also
agree to accept these conditions.

2 » Yes to download the music tone. You will
receive a text message that confirms that the
music tone is paid for and made available. The
music tone is automatically saved in My Stuff
» Sounds.

& The service may not always be available in all

countries or when you are using a network other than
your network operator’s — a message will appear to
inform you about this when selecting the Hit Picks
icon.

Ringtones and melodies

Your phone comes with a number of standard and
polyphonic melodies that can be used as ringtones.
You can exchange melodies using one of the
available transfer methods. Please note that you are
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not allowed to exchange copyright-protected
material.

G- If you select an MP3 file as a ringtone, you cannot use

voice answering, W 30 Voice answering.

To select a ringtone
» Settings » the Sounds & Alerts tab » Ringtone.

To turn the ringtone on or off
Press and hold from standby. All signals
except the alarm signal are turned on or off.

To set the ringtone volume

1 » Settings » the Sounds & Alerts tab » Ring
Volume and press ) or (@ to decrease or
increase the volume.

2 » Save to save the setting.

Caller-specific ringtones

If your subscription includes the Calling Line
Identification (CLI) service, you can assign a
personal ringtone to callers, W 24 To add a picture,
light effect or a ringtone to a phone contact.
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Vibrating alert

You can choose to be notified of an incoming call

by the buzzing of the vibrating alert. You can set:

» On—all the time.

+ Onifin Silent — on when the ring volume is
turned off or when you have set the phone to
silent.

+ Off —all the time.

To set the vibrating alert
» Settings » the Sounds & Alerts tab » Vibrating
Alert and select the setting you want.

Sounds and alerts options

From Settings » the Sounds & Alerts tab, you can

set:

» Message Alert — select how you want to be
notified of an incoming message.

» Key Sound — select what sound you want the
keys to make when you press them.

Light effects

You can choose when you want light effects to
appear:

» Always On — on all the time.

» Always Off — off all the time.
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* Onifin Silent — on only when you have set the
phone to silent.

« Off if in Silent — off only when you have set the
phone to silent.
Certain Light Effects are always on, including

powering on the phone.

To turn on light effects
» Settings » the Sounds & Alerts tab » Light Effects
» Preferences.

To set the call light pattern
» Settings » the Sounds & Alerts tab» Light Effects
» Call Light and select a light pattern.

MusicDJ™

You can compose and edit melodies to use as
ringtones using the MusicDJ"™. A melody consists
of four types of blocks — Drums, Basses, Chords
and Accents. A track contains a number of music
blocks. The blocks consist of pre-arranged sounds
with different characteristics. The blocks are
grouped into Intro, Verse, Chorus and Break. You
compose a melody by adding music blocks to the
tracks.
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To compose a melody

1 » Entertainment » MusicDJ™.

2 Choose to Insert, Copy and Paste blocks to
compose your melody. Use ), &, @) or @)
to move between the blocks. Press () to
delete a block. » More to view more options.

To edit a previously created melody
» My Stuff » Sounds and select the melody » More
» Edit.

Sending and receiving

You can send and receive melodies using one of
the available transfer methods. Please note that you
are not allowed to exchange copyright-protected
material.

G- You cannot send a polyphonic melody or an MP3 file

in a text message.

To send a melody
1 » My Stuff » Sounds and select a melody.
2 » More » Send and select a transfer method.

To receive a melody
1 Open the message you received the melody in,
or turn on Bluetooth or the infrared port if

Entertainment

these transfer methods are being used to send
the melody.

2 When you receive the melody, follow the
instructions that appear on the screen.

VideoDJ™

With the VideoDJ™, you can create movies by
combining video clips and pictures that you have
saved in your phone. You can also use VideoDJ™
to trim video clips and edit video items.

To create a movie

1 » Entertainment » VideoDJ™.

2 » Add. Select to add a Video Clip, a Picture or
Text » Select.

To edit a video clip

1 » My Stuff » Videos » Open and choose the
video clip you want to open.

2 » More » Edit » Edit to Trim, Replace or Delete
a clip from the current movie.

To edit a picture

1 » Entertainment » VideoDJ™.

2 » Add » Picture. Choose the picture you want
to edit and » Select.
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3 » Edit to Replace a picture, » Duration to
change the picture duration in the movie or
» Delete to delete the picture from the current
movie.

To edit text

» Edit to change a text string, » Background to
change the text background, » Text Color to change
the font color, » Duration to change the duration of
the text in the movie or » Delete to delete the text
from the current movie.

VideoDJ™ options

When a movie is selected, » More to view more

options:

» Preview —to view the movie.

* Insert — to insert an item.

» Save — to save the current movie.

» Send — to send the current movie.

» New — to open another movie.

» Soundtrack —to add a soundtrack to the current
movie.

Sending and receiving movies
You can send a movie using one of the available
transfer methods. Short movies can be sent using
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picture messaging. If a movie is too long, you can
use the Trim function to make a movie shorter.

Movies that you receive and save are saved in
My Stuff.

To trim a video clip

1 Select a video from the storyboard » Edit
» Trim.

2 » Set to set the start point and » Start.

3 » Set to set the end point and » End.

4 You can repeat steps 2 and 3 until you are
satisfied. » Done to finish the trim.

Sound recorder

With the sound recorder, you can record either your
own memos or calls. If you network operator or
service provider supports it, recorded sounds can
also be set as ringtones. Recording of a
conversation is stopped if a participant ends the
call. Recording of all sounds stops automatically if
you receive a call. If the recordings are saved in the
phone, they can be accessed even if you change
your SmartChip.

- In some countries or states it is required by law that

you inform the other person before recording the call.
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To start a sound recording

1 » Entertainment » Record Sound.

2 Wait until you hear a tone. When the recording
starts, Recording is displayed together with the
time of the current recording (increasing).

3 » Save to end the recording, and » Play to
listen to the recording. » More to view the
following options: Record New, Send, Rename,
Delete, Recorded Sounds.

To listen to your recordings

1 » My Stuff » Sounds and select the recording
you want to hear.

2 » Play to listen to the recording and » Stop to
stop playback.

Themes

You can change the appearance of the screen, for
example, the colors and wallpaper, by using
themes. Your phone comes with some predefined
themes. You cannot delete these, but you can create
new themes and download them to your phone. For
more information, visit
www.SonyEricsson.com/support.

Entertainment

To select or change a theme
» My Stuff » Themes and select a theme.

Exchanging themes
You can exchange themes using one of the
available transfer methods.

To send a theme
1 » My Stuff » Themes and select a theme.
2 » More » Send and select a transfer method.

To receive and save a theme

1 Open the message you received the theme in,
or turn on Bluetooth or the infrared port if
these transfer methods are being used to send
the theme.

2  When you receive the item, follow the
instructions that appear on the screen.

To download a theme
» My Stuff » Themes » Sony Ericsson.
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Games

Your phone has several entertaining games. You
can also download games and applications directly
to the folders in your phone. Help texts are
available for most games.

To start and end a game

1 » Entertainment » Games and select a game
» Select.

2 Press and hold (=) to end the game.

To download a game
» Entertainment » Games » Shop Games.
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Connectivity

Internet and email settings, synchronizing,
Bluetooth, infrared, and optional USB cable.

Settings
Before you start using Internet, messaging, IM or
Hit Picks, settings are required in your phone.

Settings may already be entered when you buy
your phone. If not, contact Cingular for more
information. Settings are also available at
www.SonyEricsson.com/support.

In order to use the Internet, and send and receive
picture and email messages, you need the
following:

* A phone subscription that supports data
transmission.

« Settings entered in your phone.

* You may also have to register as an Internet and
email user with your network operator or service
provider.

Entering Internet and email settings
If the settings are not already entered in your
phone, you can:
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* Receive settings from your network operator or
service provider. Settings are also available at
www.SonyEricsson.com/support.

 Enter or edit settings manually.

Using Internet

Your phone has a browser that uses WAP
(Wireless Application Protocol) or HTTP (Hyper
Text Transfer Protocol) to access the Internet.

To select an Internet profile

» Settings » the Connectivity tab » Internet Settings
» Internet Profiles and select the profile you want to
use.

To start browsing
» MEdia Net and select a service or » Cingular Mall
» More and select an option.

To stop browsing
» More » Exit Browser.

Connectivity

Options when browsing

» More to view different browsing options. The
options may vary depending on which site you are
visiting.

G- Ifyou select an email address when browsing a Web

site, you can send a text message to that address.

The options menu always contains the following:

« Exit Browser — disconnect and go to standby.

* Go to the homepage set for the current Internet
profile, for example, Cingular Mall.

« Bookmarks — add the site you are currently
browsing to your list of bookmarks, or view the
list of bookmarks. Select to stream music or
videos.

« Enter Address — enter the Web page address of a
site you want to visit. » New Address to enter a
new Web page address or select one of the 10
latest entered addresses. When you enter a Web
page address, the normal http:// prefix is not
needed.

« Clear Cache — clear all temporary stored Internet
files saved in the phone.

« History — list of previously visited sites.

« Refresh Page — refresh the contents of the Web

page.
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Save — save the Web page or a picture from the
current Web page.

Send Link — send a link to the current site to
another phone.

Status — display current status information, for
example, profile, access type, security, address.
Appearance — select to play the sounds or show
the pictures on visited pages.

Make a Call — if your subscription supports it,

you can make a call while browsing the Internet.

» More » End Call to end the call and continue
browsing.

Using bookmarks

You use bookmarks in your mobile phone just as
you do with a computer Internet browser. You can
create and edit bookmarks.

To work with bookmarks

1

» MEdia Net » More » Bookmarks and select a
bookmark » More.

2 Select an option.
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Downloading

You can download, for example, pictures, themes,
games and ringtones from Web sites directly to
your phone.

@ Contact Cingular for more information if menu
options are not available.

To download from

wap.sonyericsson.com

1 » MEdia Net » More » Bookmarks » Sony
Ericsson.

2 Select what you want to download and follow
the instructions that appear.

Stored information
When browsing, you can save information in your
phone.

-G It is advisable to clear any sensitive information about
previously visited Internet services. This is to avoid a
security risk if your phone is misplaced, lost or stolen.

The following information can be saved:
« Cookies — improve site access efficiency.
« Passwords — improve server access efficiency.
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To allow or clear cookies in your
phone

Press Settings » the Connectivity tab » Internet
Settings » Cookies and select an option and
confirm.

To clear the password list

» Settings » the Connectivity tab » Internet Settings

» Clear Passwords and » Yes to confirm.

Internet profile for Java™
applications
Some Java™ applications need to connect to the

Internet to receive information, for example, games

that download new levels from a game server.
You need an HTTP Internet profile to allow

Java™ applications to connect to the Internet.

Please contact Cingular for the correct settings.

To select a profile for Java™

1 » Settings » the Connectivity tab » Settings for

Java™ » Internet Profiles.
2 Select the HTTP profile you want to use.

Internet security
Your phone has support for both WAP and HTTP

secure browsing. To activate a secure connection to

Connectivity

the WAP gateway, you need to turn on security in
your Internet profile. If your Internet profile is an
HTTP profile, the connection will be secure if the
URL starts with https://.

G- Security for a connection between a WAP gateway and

a WAP service provider is the responsibility of the
WAP service provider.

To turn on a secure connection (WAP)

1 » Settings » the Connectivity tab » Internet
Settings » Internet Profiles and select a profile
» More » Settings.

2 Turn on security.

Trusted certificates

To establish a secure connection when using
certain Internet services, for example, banking, you
need certificates in your phone.

Trusted certificates are used to verify the WAP
gateway or the HTTP server that you are
connecting to. Your phone may already contain
trusted certificates when you buy it. You can also
download new certificates using the browser.
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To check the certificates in your
phone

» Settings » the Connectivity tab » Internet Settings
» Security » Trusted Cert.

Synchronizing

You can synchronize your phone contacts,
appointments, tasks and notes with similar
programs in, for example, a computer or mobile
phone using Bluetooth, the infrared port or the
optional USB cable (synchronization with nearby
devices).

You can also synchronize with programs on the
Internet using WAP or HTTP (remote
synchronization with Internet services).

Please visit www.SonyEricsson.com/support to
download the synchronization software and getting
started guides on synchronization.

To select sync order for names

» Address Book » Options » Advanced

» Synchronize Order to select the order in which
first and last name appear in the phone when you
synchronize contacts.
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Synchronization with nearby devices
Download and install the synchronization program
from www.SonyEricsson.com/support. For detailed
information, please refer to the computer
synchronization software help.

Remote synchronization with
Internet programs

Contact Cingular for more information about the
programs on the Internet with which you can
synchronize, and to receive username, password
and addresses for the different programs. You must
also have an Internet profile set in your mobile
phone B 68 Settings.

To enter the remote synchronization

settings

1 » Organizer » Synchronization » New Account.
If you do not have an account, you will be
asked if you want to create an account. > Yes
to create a new account.

2 Enter a name for the new account » Continue.
A list of items to enter will appear. Add the
server address of the synchronization server, a
server username and a server password. » OK
when you have entered each setting.
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3 » Connection and select the WAP or HTTP
profile that you want to use for the
synchronization.

4 » Remote Initiation to set wheter to allow the
synchronization server or other device to
initiate a synchronization or not. You can also
choose to always be asked.

5 » Sync. Interval to set how often you want the
phone to automatically connect to the server
and start syncronization.

6 » Applications and select the applications that
you want to synchronize, for example,
Contacts » OK.

7 » App. Settings and select an application. Enter
the name of the database and, if required, your
username and password » OK.

8  Press () > Save to save your new account.

To start the remote synchronization
» Organizer » Synchronization and select a remote
account » Start.

O
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Bluetooth™ wireless
technology

Your phone has built-in Bluetooth which makes it
possible for you to connect your phone wirelessly
to other Bluetooth devices. You are able to be
connected to several Bluetooth devices at the same
time. You can automatically synchronize
information in your phone and your computer and
use the remote control functionality to control
applications on your computer. You can also
exchange, for example, business cards, calendar
items and pictures.

We recommend that your phone and the Bluetooth
device you are communicating with are within a range
of 33 feet (10 meters). The connection may be
improved if there are no solid objects between your
phone and the other Bluetooth device.

Before you start

To communicate with another Bluetooth device,
you first need to turn Bluetooth on. You can also
add the device to the list of devices in your phone.
You can exchange items, use a remote screen and
play games without adding the device to the list. To
synchronize with your computer and browse the
Internet, you also need to install software on your
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computer. You can download it from:
www.SonyEricsson.com/support.

- Please check if local laws or regulations restrict the

use of Bluetooth. If Bluetooth is not allowed, you must
ensure that the Bluetooth function is turned off. The

maximum allowed Bluetooth radio output power in the
phone is automatically adjusted according to possible
local restrictions. This means that the range may vary.

To turn Bluetooth on
» Settings » the Connectivity tab » Bluetooth
» Turn On.

To add a device to your phone

1 » Settings » the Connectivity tab » Bluetooth
» My Devices » New Device. The Bluetooth
function of the other device must also be on
and not hidden.

2 » Add and your phone will search for all types
of available Bluetooth devices.

3 The phone searches for Bluetooth devices. A
list of available devices is displayed. Select a
device.

4 If the device you are adding to your phone has
its own passcode, enter this passcode in your
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phone. If not, create a passcode of digits
yourself and enter it in both devices.

To organize your list of devices

1 » Settings » the Connectivity tab » Bluetooth
» My Devices and select a device from the list.

2 » More to view a list of options.

Power save

You can choose to turn this feature on or off if you
do not want to use several Bluetooth functions at
the same time. If you turn it on, the phone will save
power and it will prevent other devices from
connecting to your phone when you are already
connected to one.

To save power
» Settings » the Connectivity tab » Bluetooth
» Power Save » On.

Phone name

Choose a unique name for your phone. This name
is shown in other devices when your phone is
found.
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To enter a phone name
» Settings » the Connectivity tab » Bluetooth
» Phone Name.

Visibility

In order for your phone to be found when searched
for by other Bluetooth devices, you must make sure
that Bluetooth is turned on and your phone is
visible to other devices.

To hide or show your phone when

using Bluetooth

1 » Settings » the Connectivity tab » Bluetooth
» Visibility.

2 » Show Phone or Hide Phone.

Sending and receiving
To send or receive an item using Bluetooth, you

need to make sure that the devices are within range.

After you select Bluetooth as the transfer
method for sending, a list of possible receiving
devices is presented. The phone also searches for
other devices that are shown in the list.

To send an item
1 Select the item that you want to send,
» Address Book and select a contact.

Connectivity

2 » More » Send Contact » Via Bluetooth. The
phone searches for devices.

3 Select the device you want to send the item to
» Select.

To receive an item

» Settings » the Connectivity tab » Bluetooth

» Turn On. Make sure that your phone is visible to
other devices. When you receive the item, follow
the instructions that appear on the screen.

To add a Bluetooth handsfree to your

phone

1 » Settings » the Connectivity tab » Bluetooth
» Handsfree.

2 The first time you add a handsfree, Add a
handsfree device to use with the phone? is
displayed » Yes.

3 If you already have a handsfree in your list of
devices, > Settings » the Connectivity tab
» Bluetooth » Handsfree » My Handsfree
» New Handsfree » Add. You should ensure
that your Bluetooth handsfree is in pairing
mode.
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Transferring sound

When you are using a Bluetooth handsfree with
your phone, you can choose where the sound
should be transferred during a call. You can also
select where the sound should be handled when
answering an incoming call with the keypad.

To transfer sound when using a
handsfree

During a call, press @ » Transfer Sound. Select to
transfer sound either to the phone or to other
handsfree devices that have been added to your
phone.

Directing sound

You can select where the sound should be handled
when answering an incoming call with the keypad
on the phone. If you use the button on the
handsfree, the sound will always be in the
handsfree.

To direct sound when answering a
call with a handsfree

1 » Settings » the Connectivity tab » Bluetooth
» Handsfree » Incoming Call.
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2 » InPhone if you always want to have the
sound in the phone or In Handsfree if you want
to direct the sound to the handsfree.

Remote control

You can use your phone as a remote control device
to control computer applications such as a media
player or Microsoft~ PowerPoint™ presentations.
Your computer must support Bluetooth HID
Profile.

To select remote control

1 » Entertainment » Remote Control.

2 Select the application you want to use and the
computer you want to connect to.

File transfer

You can use a computer to view and transfer

content in My Stuff. You can use the drag-and-drop

function of your computer to:

« Transfer files between your phone and the
computer.

* Delete files from the phone.
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Infrared port

You can use the infrared port to establish contact

between your phone and a computer or another

device equipped with an infrared port. You can, for

example, synchronize calendar items,
® 72 Synchronizing, and send items such as
pictures and contacts.

G- If you are connecting to a computer, please refer to its
user documentation. Make sure that the infrared speed

in the computer is set to 115200 bps.

To turn the infrared port on

» Settings » the Connectivity tab » Infrared Port
» On or » 10 minutes to turn on infrared for

10 minutes only.

Connectivity

To connect two devices

Turn on the infrared port of both devices.
Make sure that the infrared port on your phone
faces the infrared port on the other device.
Your phone now establishes contact with the
other device.

To send an item using the infrared
port (example: a contact)

1

Make sure that the infrared ports of both
devices are on. » Address Book and select a
contact.

» More » Send Contact » Via Infrared.
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More features

Time and date, alarm clock, calendar, tasks,
Java™ applications, SmartChip lock, etc.

Time and date

The time is always displayed in standby.

* To set the time » Settings » the General tab
» Time & Date » Time. Enter the time » Save.

* To set the time format » Format and select an
option.

» To set the date and date format » Settings » the
General tab » Time & Date » Date.

Alarm clock

The alarm can be set to ring at a specific time
within 24 hours, or recurrently at a specific time on
several days. You can have both these alarms set at
the same time. The alarm signal rings even if the
phone is set to silent or turned off.

To set an alarm
» Organizer » Alarms » One-Time Alarm and enter
the time » Save.

Draft for Internal Use Only - PA2

Using the alarm

» To change the alarm time » Organizer »-Alarms
» One-Time Alarm and enter a new time.

 To turn the alarm signal off when it rings, press
any key. If you do not want the alarm to be
repeated » Turn Off.

» To cancel the alarm » Organizer » Alarms » One-
Time Alarm » Turn Off.

» To set a recurrent alarm » Organizer » Alarms
» Recurrent Alarm. Enter the time and select the
days that you want the alarm to recur on by
scrolling and pressing Mark. » Done to exit the
menu.

» To select an alarm signal » Organizer » Alarms
» Alarm Signal. Select a sound.

Calendar

You can use the calendar to keep track of important
meetings. The calendar can be synchronized with a
computer calendar or with a calendar on the Web,
= 72 Synchronizing.

Appointments

You can choose to add a new appointment or use
an old one as a template by copying and editing it.
You can also set reminders for appointments.
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To add a new appointment

1 » Organizer » Calendar, highlight the date for
the appointment » Select » New Appointment
» Add.

2 Enter details and confirm each entry.

To view an appointment

1 » Organizer » Calendar and select a day on
which you have an appointment (marked in
bold).

2 Scroll to the appointment » View.

To view your calendar content

» Organizer » Calendar. Days on which you have
appointments are marked in bold. » More » View
Week to view a certain week.

To set when reminders should sound

1 » Organizer » Calendar » More » Advanced
» Reminders.

2 » Always if you want the reminder to sound
even though the phone is turned off. When the
reminder sounds » Yes to read the
appointment. » No to turn off the reminder. A
reminders option set in the calendar affects a
reminders option set in tasks.

More features

Navigating in your calendar

Use the navigation key to move between days or
weeks. In the monthly and weekly views, you can
also use the keypad as follows.

@ Back a week @ Next week
@ Back a month @ Next month
Back a year @ Next year

@ Today s date

Calendar settings

» Organizer » Calendar » More and select an

option.

« View Week — select, add, edit or delete
appointments.

« New Appointment — add a new appointment.

+ Change Date — change the date of your calendar.

« Advanced — for options to find, delete all, set
reminders or select a start day for the week.

Exchanging appointments

You can send and receive appointments using one
of the available transfer methods.
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To send an appointment

In the list of appointments for a certain day, select
the item you want to send » More » Send and select
a transfer method.

Tasks

You can keep track of phone calls you need to
make or tasks that you need to do. You can choose
to add a new task or use an old one as a template by
copying and editing it. You can also set a reminder
for a task.

To add a new task

1 » Organizer » Tasks » New Task » Add.

2 Select a category. If the category is a phone
call, enter the phone number » Continue.

3 Enter a subject » Continue.

4 If you want to set a reminder for your task
» Yes.

To view a task
» Organizer » Tasks and select a task » View.

To set when reminders should sound
1 » Organizer » Tasks and select a task » More
» Reminders.
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2 » Always if you want the reminder to sound
even though the phone is turned off. When the
reminder sounds » Yes to read the task, or to
call the phone number in a phone task. » No to
turn off the reminder. A reminders option set
in tasks affects a reminders option set in the
calendar.

Exchanging tasks

You can send and receive tasks using one of the
available transfer methods. You can also
synchronize tasks with a computer,

® 72 Synchronizing.

To send a task

1 Inthe list of tasks for a certain day, select the
item you want to send » More » Send.

2 Select a transfer method.

Notes
If you need to remember something, you can make
a note of it in your phone.

To add a note
» Organizer » Notes » New Note » Add and enter
the note » Save.
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To handle notes

1 » Organizer » Notes and a list of notes appears.

2 Select the note that you want to handle. » More
to edit, show a note in standby (or hide it),
send or delete a note.

Exchanging notes

You can send and receive notes using one of the
available transfer methods. You can also
synchronize notes with a computer,

® 72 Synchronizing.

To send a note

» Organizer » Notes and select the note that you
want to send » More » Send and select a transfer
method.

Profiles

Your phone has predefined profiles that are set to
suit a certain environment. You can reset all profile
settings to the way they were set when you bought
your phone.

To select a profile
» Settings » the General tab » Profiles » Select
Profile.

More features

To change a profile setting

» Settings » the General tab » Profiles » Edit
Profile and select the setting that you want to
change.

To rename a profile

» Settings » the General tab » Profiles » Edit
Profile » Profile Name. You cannot rename the
normal profile.

Stopwatch

Your phone has a stopwatch that can save several
laps. The stopwatch continues to run when you
answer an incoming call.

To use the stopwatch
1 » Organizer » Stopwatch » Start.

2 » Stop or » New Lap if you want a lap time.
3 To reset the stopwatch » Reset.

Timer
To set the timer

» Organizer » Timer and enter the hours, minutes
and seconds after which you want the timer to go
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oft. When the signal rings, press any key to turn it
off.

Brightness
You can adjust the brightness of the screen.

;@: Some functions use more battery power than others
and may cause a need for more frequent re-charging.

To set the brightness
» Settings » the Display tab » Brightness.

@ Startup screen
When you turn your phone on or off, the startup
screen appears. You can also set your own startup
screen.

To select a startup screen
» Settings » the Display tab » Startup Screen and
select an option for the startup screen.

Calculator

The calculator can add, subtract, divide and
multiply.
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To use the calculator

» Organizer » Calculator.

* Press 0) or © to select + x -+ % =.
* Press (¢) to delete the figure.

e Press to enter a decimal point.

Java™ applications

You can run Java™ applications on your phone.
Games and other Java applications can be
downloaded to your phone from the Internet.

Java application security

Java applications are automatically installed as
“Trusted” or “Untrusted”. Trusted applications are
allowed to, for example, connect to networks, send
messages or use the camera without asking for
permission. Untrusted applications, however, must
always confirm such actions with you first. You
can set different permission levels for your Java
applications.

To set permissions for a Java™

application

1 » My Stuff » Applications or » Games.

2 Select an application or a game » More
» Permissions.
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3 » Internet Access, Messaging or Multimedia.

4 » Never Ask, Always Ask or Ask Once to set the
permission level you want for the application.

Java application screen size

Some Java applications are designed for a specific
screen size. In some cases, applications may not be

able to start because the phone cannot adapt the
application to the screen. Contact the application

vendor to find out what screen size the application
is designed for, and change the screen settings for

the application in the phone.

To set the screen size for a Java

application

1 » My Stuff » Applications or » Games.

2 Select an application or a game » More
» Screen Size.

3 Select one of the listed options. If you selected

User Defined you can edit the Width: and
Height: values.

SmartChip lock

The SmartChip lock protects your subscription, but

not your phone itself, from unauthorized use.

More features

Most SmartChips are locked at the time of
purchase. If the SmartChip lock is on, you have to
enter a PIN (Personal Identity Number) every time
you turn on your phone.

If you enter your PIN incorrectly three times in a
row, the SmartChip is blocked. This is indicated by
the message PIN Blocked. To unblock it, you need
to enter your PUK (Personal Unblocking Key).
Your PIN and PUK are supplied by your network
operator. You can edit your PIN and select a new
four- to eight-digit PIN.

- If the message Codes do not match appears when you

edit your PIN, you entered the new PIN incorrectly. If
the message Wrong PIN appears, followed by Old
SmartChip:, you entered your old PIN incorrectly.

To unblock your SmartChip

1 When PIN Blocked is displayed, enter your
PUK » OK.

2 Enter a new four- to eight-digit PIN » OK.

3 Re-enter the new PIN to confirm » OK.

To edit your PIN

1 » Settings » the General tab » Locks
» SmartChipLock » Change PIN.

2 Enter your PIN » OK.
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3 Enter a new four- to eight-digit PIN » OK.
4 Re-enter the new PIN to confirm » OK.

To turn the SmartChip lock on or off
1 » Settings » the General tab » Locks
» SmartChipLock » Protection and select On or
Off.
2  Enter your PIN » OK.

Phone lock

The phone lock protects your phone against
unauthorized use if it is stolen and the SmartChip is
exchanged. You can change the phone lock code
(0000) to any four- to eight-digit personal code.

Automatic phone lock

If the phone lock is set to automatic, you do not
need to enter your phone lock code until a different
SmartChip is inserted in the phone.

- It is important that you remember your new code. If
you should forget it, you have to take your phone to
your local Sony Ericsson retailer.

To set the phone lock
1 » Settings » the General tab » Locks » Phone
Lock » Protection and select an alternative.

Draft for Internal Use Only - PA2

2 Enter the phone lock code » OK.

To unlock the phone
If the phone lock is on, enter your code » OK.

To edit your phone lock code
» Settings » the General tab » Locks » Phone Lock
» Change Code.

Code memo

Instead of having to remember security codes for
credit cards, for example, you can save them in the
code memo in your phone. All you need to
remember is the passcode to open the code memo.

Checkword and security

To confirm that you have entered the correct
passcode for the code memo and to prevent
unauthorized access to your codes, you must enter
a checkword.

When you enter your passcode to open the code
memo, the checkword is shown for a short time. If
the passcode is correct, the correct codes are
shown. If you enter the incorrect passcode, the
checkword and the codes that are shown are also
incorrect.
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To open code memo for the first time

1

2

3
4

» Organizer » Code Memo. A message with
instructions is displayed » Continue.

Enter a four-digit passcode to open code memo
» Continue.

Re-enter the new passcode to confirm.

Enter a checkword (maximum 15 characters)
» Done. The checkword can consist of both
letters and numbers.

To add a new code

1

2

3

» Organizer » Code Memo and enter your
passcode » New Code » Add.

Enter a name associated with the code,

» Continue.

Enter the code » Done.

To change the passcode

1

2
3

Open code memo as described above » More
» Change Passcode.

Enter your new passcode » Continue.
Re-enter the new passcode » Continue.
Enter a checkword » Done.

More features

Forgot your passcode?
If you forget your passcode, you must reset the
code memo.

To reset code memo

1 » More » Reset.

2 Reset Code Memo? is displayed » Yes. The
code memo is reset and all entries are cleared.
The next time you enter the code memo, you
must start by opening the code memo for the
first time.
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Troubleshooting
Why doesn’t the phone work the way I want?

This chapter lists some problems that you might
encounter while using your phone. Some problems
require you to call your network operator, but you
can easily correct most of the problems yourself.

However, if you need to hand in your phone for
repair, please note that you may lose information
and content that you have saved in your phone.
You are advised to make a copy of such
information before handing your phone in for
repair.

For more support go to
www.SonyEricsson.com/support.

I have problems with memory
capacity or the phone working slowly
Possible cause: The phone memory may be full.
Solution: Restart your phone every day to free

memory and increase the capacity of
j'- z

your phone.

You also have the option to do a Master
Reset. Some of your personal data and
settings you have made will be lost
when doing this. W 88 Master reset.
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No battery icon appears when I start
charging the phone

Possible cause: The battery is empty or has not
been used for a long time.

Solution: It may take up to 30 minutes before the
battery icon appears on the screen.

Some menu options appear in grey
Possible cause: Grey text indicates a function that
is temporarily unavailable. A service is not
activated or your subscription does not support the
function.

Solution: Contact Cingular.

Possible cause: Since you cannot send themes,
pictures and sounds that are copyright-protected,
the Send menu is sometimes unavailable.

The wrong language appears on my
phone

Possible cause: The wrong language is set in the
phone.

Solution: Change the language, W 16 Phone
language.

I cannot turn on the phone
Possible cause: The battery is discharged.
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Solution: Recharge the battery, W 8 To charge the
battery.

Solution: Make sure you attached the charger
correctly. Turn the phone on with the charger
attached. If the phone starts, restart the phone with
no charger attached.

I cannot charge the phone or battery
capacity is low

Possible cause: The charger is not properly
connected to the phone.

Solution: Make sure that the charger connector
clicks properly into place when connected. The
battery icon flashes when charging is in progress,
and stops when the battery is fully charged, ® 8 To
charge the battery.

Possible cause: The battery connection is bad.
Solution: Remove the battery and clean the
connectors. You can use a soft brush, cloth or
cotton swab, soaked with alcohol. Make sure that
the battery is completely dry before you put it back.
Check that the battery connectors in the phone are
undamaged.

Possible cause: The battery is worn out and needs
to be replaced.

Solution: Try another battery and charger for the
same phone model, or visit your retailer and ask

Troubleshooting

them to verify if the battery and charger are
working properly.

The phone turns itself off

Possible cause: The battery connection is bad.
Solution: Make sure the battery is inserted
correctly, W 8 To insert SmartChip and battery.

I cannot use SMSitext messages on

my phone

Possible cause: Settings are missing or incorrect.

Solution: Contact Cingular to find out the correct

SMS service center setting, W 46 Text messaging
(SMS).

I cannot use MMS messages on my
phone

Possible cause: Your subscription does not include
data capability.

Solution: Please contact Cingular.

Possible cause: Settings are missing or incorrect.
Solution: Go to www.SonyEricsson.com/support,
choose your phone model, then choose “Phone
setup — MMS” and follow the instructions.

W 68 Settings.
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I cannot use the Internet/WAP

Possible cause: Your subscription does not include
data capability.

Solution: Please contact Cingular.

Possible cause: Internet settings are missing or
incorrect.

Solution: Go to www.SonyEricsson.com/support,
choose your phone model, then choose “Phone
setup — WAP” and follow the instructions.

W 68 Settings.

The phone cannot be detected by
other users via Bluetooth

Possible cause: You have not turned Bluetooth on.
Solution: Make sure that Bluetooth is turned on and
that your phone is visible to other users. B 75 To
hide or show your phone when using Bluetooth.

Master reset

The changes that you have made to settings and the

content that you have added or edited, will be

deleted.

+ Ifyouselect Reset Settings, the changes that you
have made to settings will be deleted.

+ Ifyou select Reset All, in addition to your
changes to settings, all contacts, messages,
personal data, and content that you have
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downloaded, received or edited will also be
deleted.

To reset the phone

» Settings » the General tab » Master Reset.
» Reset Settings or » Reset All.

» Yes to continue.

Enter the phone lock code (0000 or the new
code if you have changed it) » OK.

BDWN=

@ If you select Reset All, content such as melodies and

pictures that you have downloaded, received or edited
is also deleted.

Error messages

Insert SmartChip

Possible cause: There is no SmartChip in the phone
or you may have inserted it incorrectly.

Solution: Insert a SmartChip. # 8 To insert
SmartChip and battery.

Possible cause: The SmartChip connectors need
cleaning.

Solution: Remove the SmartChip and clean it. Also
check that the card is not damaged in a way that
may prevent connection to the phone connectors. In
that case, contact Cingular for a new SmartChip.
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Insert Correct SmartChip

Possible cause: The phone is set to work only with
certain SmartChip.

Solution: Check if you are using the correct
operator SmartChip for your phone.

Wrong PIN/Wrong PIN2

Possible cause: You have entered your PIN or
PIN2 incorrectly.

Solution: Enter the correct PIN or PIN2 » Yes.
® 83 SmartChip lock.

PIN Blocked/PIN2 Blocked

Possible cause: You have entered your PIN or
PIN2 code incorrectly three times in a row.
Solution: To unblock, W 83 SmartChip lock.

Codes do not match

Possible cause: The two codes that you have
entered do not match.

Solution: When you want to change a security code
(for example your PIN) you have to confirm the
new code by entering exactly the same code again.
W 83 SmartChip lock.

Troubleshooting

No Netw. Coverage

Possible cause: Your phone is not receiving any
radio signal, or the received signal is too weak.
Solution: Contact Cingular and make sure that the
network has coverage where you are. If so, try to
do a new search.

Possible cause: The SmartChip is not working
properly.

Solution: Insert your SmartChip in another phone.
If you still get the same or a similar message,
please contact Cingular.

Possible cause: The phone is not working properly.
Solution: Insert your SmartChip in another phone.
If this works, it is probably the phone that is
causing the problem. Please contact the nearest
Sony Ericsson service location.

Emerg. Calls Only

Possible cause: You are within range of a network,
but you are not allowed to use it. However, in an
emergency, some network operators allow you to
call the international emergency number 112.
Solution: You have to move to get a signal that is
strong enough. Contact Cingular and make sure
your subscription is ok. W 22 Emergency calls.
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Phone Locked
Possible cause: The phone is locked.
Solution: To unlock the phone, W 84 Phone lock.

Phone Lock Code:

Possible cause: The phone lock code is required.
Solution: Enter the phone lock code. Your phone
comes with the default phone lock code 0000.You
can change it to any four- to eight-digit code.

™ 84 Phone lock.

PUK Blocked

Possible cause: You entered your personal
unblocking key code (PUK) incorrectly 10 times in
arow.

Solution: Contact Cingular.

Charging-Non-standard Battery

Possible cause: The battery that you are using is
not a Sony Ericsson approved battery.

Solution: W 94 Battery Use and Care.
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Sony Ericsson Consumer Web site, safe and
efficient use, warranty, declaration of conformity.

Sony Ericsson Consumer Web site

On www.SonyEricsson.com/support there is a
support section where help and tips are only a few
clicks away. Here you find the latest computer
software updates and tips on how to use your product
more efficiently.

Accessible Solutions/Special Needs
For phones sold in the US, you can use your TTY
terminal with your Sony Ericsson mobile phone (with
the necessary accessory). For information on
Accessible Solutions for individuals with special
needs call the Sony Ericsson Special Needs Center
at 877-878-1996 (TTY) or 877-207-2056 (voice), or
visit the Sony Ericsson Special Needs Center at
www. SonyEricsson-snc.com.

Guidelines for Safe and
Efficient Use

Please read this information before using

your mobile phone. j\ 1 /f
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Recommendations

« Always treat your product with care and keep it in

a clean and dust-free place.

« Do not expose your product to liquid or moisture or

humidity.

» Do not expose your product to extreme

high or low temperatures. 4

* Do not expose your product to open

flames or lit tobacco products. >60°C/140°F

* Do not drop, throw or try to bend your
product.

* Do not close your product with an
object inserted between keypad and
display; this may damage your
product.

* Do not paint your product.

* Do not use your product near medical equipment

without requesting permission.
+ Do not use your product when in, or around

aircraft, or areas posted “turn off two-way radio”.

* Do not use your product in an area where a
potentially explosive atmosphere exists.

« Do not place your product or install wireless
equipment in the area above your car’s air bag.

* Do not attempt to disassemble your
product. Only Sony Ericsson
authorized personnel should perform
service.

Important Information

Antenna

Only use an antenna that has been specifically
designed by Sony Ericsson for your mobile phone.
Use of unauthorized or modified antennas could
damage your mobile phone and may violate
regulations, causing loss of performance and SAR
levels above the recommended limits (see below).

Efficient Use

Hold your mobile phone as you would any other
phone. Do not cover the top of the phone when in
use, as this affects call quality and may cause the
phone to operate at a higher power level than
needed, thus shortening talk and standby times.

Radio Frequency (RF) Exposure and
SAR

Your mobile phone is a low-power radio transmitter
and receiver. When it is turned on, it emits low levels
of radio frequency energy (also known as radio
waves or radio frequency fields).

Governments around the world have adopted
comprehensive international safety guidelines,
developed by scientific organizations, e.g. ICNIRP
(International Commission on Non-lonizing Radiation
Protection) and IEEE (The Institute of Electrical and
Electronics Engineers Inc.), through periodic and
thorough evaluation of scientific studies. These
guidelines establish permitted levels of radio wave
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exposure for the general population. The levels
include a safety margin designed to assure the safety
of all persons, regardless of age and health, and to
account for any variations in measurements.
Specific Absorption Rate (SAR) is the unit of
measurement for the amount of radio frequency
energy absorbed by the body when using a mobile
phone. The SAR value is determined at the highest
certified power level in laboratory conditions, but the
actual SAR level of the mobile phone while operating
can be well below this value. This is because the
mobile phone is designed to use the minimum power
required to reach the network.

Variations in SAR below the radio frequency
exposure guidelines do not mean that there are
variations in safety. While there may be differences in
SAR levels among mobile phones, all Sony Ericsson
mobile phone models are designed to meet radio
frequency exposure guidelines.

For phones sold in the US, before a phone model is
available for sale to the public, it must be tested and
certified to the FCC that it does not exceed the limit
established by the government-adopted requirement
for safe exposure. The tests are performed in
positions and locations (that is, at the ear and worn
on the body) as required by the FCC for each model.
For body worn operation, this phone has been tested
and meets FCC RF exposure guidelines when the
handset is positioned a minimum of 20 mm from the
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body without any metal parts in the vicinity of the
phone or when used with the original Sony Ericsson
body worn accessory intended for this phone. Use of
other accessories may not ensure compliance with
FCC RF exposure guidelines.

A separate leaflet with SAR information for this
mobile phone model is included with the material that
comes with this mobile phone. This information can
also be found, together with more information on
radio frequency exposure and SAR, on:
Www.sonyericsson.com.

Driving

Please check if local laws and regulations restrict the
use of mobile phones while driving or require drivers
to use handsfree solutions. We recommend that you
use only Sony Ericsson handsfree solutions intended
for use with your product. Please note that because
of possible interference to electronic equipment,
some vehicle manufacturers forbid the use of mobile
phones in their vehicles unless a handsfree kit with
an external antenna supports the installation.
Always give full attention to driving and pull off the
road and park before making or answering a call if
driving conditions so require.

Personal Medical Devices
Mobile phones may affect the operation of cardiac
pacemakers and other implanted equipment. Please
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avoid placing the mobile phone over the pacemaker,

e.g. in your breast pocket. When using the mobile

phone, place it at the ear opposite the pacemaker. If

a minimum distance of 6 inches (15 cm) is kept
between the mobile phone and the pacemaker, the

risk of interference is limited. If you have any reason

to suspect that interference is taking place,

immediately turn off your mobile phone. Contact your

cardiologist for more information.
For other medical devices, please consult the
manufacturer of the device.

CHILDREN

DO NOT ALLOW CHILDREN TO PLAY

ACCESSORIES. THEY COULD HURT gﬁ

n

THEMSELVES OR OTHERS, OR L

WITH YOUR MOBILE PHONE OR ITS H

COULD ACCIDENTALLY DAMAGE THE

MOBILE PHONE OR ACCESSORY. YOUR MOBILE

PHONE OR ITS ACCESSORY MAY CONTAIN

SMALL PARTS THAT COULD BE DETACHED AND

CREATE A CHOKING HAZARD.

Disposal of old electrical & electronic

equipment

This symbol on the product or on its packaging
indicates that this product shall not be treated as
household waste. Instead it shall be handed over to
the applicable collection point for the recycling of

Important Information

electrical and electronic equipment. By ensuring this
product is disposed of correctly, you will help prevent
potential negative consequences for the environment
and human health, which could otherwise be caused
by inappropriate waste handling of this product. The
recycling of materials will help to conserve natural
resources. For more detailed information about
recycling of this product, please contact your local
city office, your household waste disposal service or
the shop where you purchased the product.

Power Supply

Connect the AC power adapter only to designated
power sources as marked on the product. Make sure
the cord is positioned so that it will not be subjected
to damage or stress. To reduce risk of electric shock,
unplug the unit from any power source before
attempting to clean it. The AC power adapter must
not be used outdoors or in damp areas. Never alter
the cord or plug. If the plug will not fit into the outlet,
have a proper outlet installed by a qualified
electrician.

Emergency Calls

Mobile phones operate using radio signals, which
cannot guarantee connection under all conditions.
Therefore you should never rely solely upon any
mobile phone for essential communications (e.g.
medical emergencies).
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Emergency calls may not be possible on all cellular
networks or when certain network services and/or
mobile phone features are in use. Check with your
local service provider.

Battery Use and Care

We recommend that you fully charge the battery

before you use your mobile phone for the first time.

The battery should only be charged in temperatures

between +41°F (+5°C) and +113°F (+45°C).

A new battery or one that has not been used for a

long time could have reduced capacity the first few

times it is used.

The talk and standby times depend on the actual

transmission conditions when using the mobile

phone. If the mobile phone is used near a base
station, less power is required and talk and standby
times are prolonged.

* Warning! May explode if disposed of in fire.

+ Use only Sony Ericsson branded original batteries
and chargers intended for use with your mobile
phone. Other chargers may not charge sufficiently
or may produce excessive heat. Using other
batteries and chargers could be dangerous.

» Do not expose the battery to liquid.

+ Do not let the metal contacts on the battery touch
another metal object. This could short-circuit and
damage the battery.

+ Do not disassemble or modify the battery.
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« Do not expose the battery to extreme
temperatures, never above +140°F /
(+60°C). For maximum battery
capacity, use the battery in room >60°C/140°F
temperature.

« Turn off your mobile phone before removing the
battery.

» Keep out of children’s reach.

 Use the battery for the intended
purpose only. g:, a

* Do not allow the battery to be put into v
the mouth. Battery electrolytes may be
toxic if swallowed.

» Do not close your phone with an object inserted
between keypad and display; this may cause
damage to the phone.

Disposing of the Battery

of batteries or call your local

Please check local regulations for disposal
Sony Ericsson Call Center for information. g

The battery should never be placed in
municipal waste. Use a battery disposal
facility if available.

End User Licence Agreement
This wireless device (“Device”) contains software
owned by Sony Ericsson Mobile Communications AB
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(“Sony Ericsson”), its affiliates and its third party
suppliers and licensors (“Software”).

As user of this Device, Sony Ericsson grants you a
non-exclusive, non-transferable, non-assignable

license to use the Software solely in conjunction with

the Device on which it is installed. Nothing herein

shall be construed as a sale of the Software to a user

of this Device.
You shall not reproduce, modify, distribute, reverse

engineer, decompile, otherwise alter or use any other
means to discover the source code of the Software or

any component of the Software. For avoidance of

doubt, you are at all times entitled to transfer all rights
and obligations to the Software to a third party, solely
together with the Device with which you received the

Software, provided always that such third party
agrees in writing to be bound by these rules.

You are granted this license for a term of the useful
life of this Device. You can terminate this license by

transferring all your rights to the Device on which you
have received the Software to a third party in writing.

If you fail to comply with any of the terms and

conditions set out in this license, it will terminate with

immediate effect.

Sony Ericsson and its third party suppliers and
licensors are the sole and exclusive owner of and
retain all rights, title and interest in and to the
Software. Sony Ericsson, and, to the extent that the
Software contains material or code of a third party,
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such third party, shall be entitled third party
beneficiaries of these terms.

The validity, construction and performance of this
license shall be governed by the laws of Sweden.
The foregoing shall apply to the full extent permitted
by, when applicable, statutory consumer rights.

Limited Warranty

Sony Ericsson provides this Limited Warranty for
your mobile phone and original accessory delivered
with your mobile phone (hereinafter referred to as
“Product”).

Should your Product need warranty service, please
return it to the dealer from whom it was purchased, or
contact your local Sony Ericsson Call Center
(national rates may apply) or visit

www. SonyEricsson.com to get further information.

Our warranty

Subject to the conditions of this Limited Warranty,
Sony Ericsson warrants this Product to be free from
defects in design, material and workmanship at the
time of its original purchase by a consumer, and for a
subsequent period of one (1) year.

What we will do

If, during the warranty period, this Product fails to
operate under normal use and service, due to defects
in design, materials or workmanship, Sony Ericsson
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authorized distributors or service partners, in the
country/region* where you purchased the Product,
will, at their option, either repair or replace the
Product in accordance with the terms and conditions
stipulated herein.

Sony Ericsson and its service partners reserve the
right to charge a handling fee if a returned Product is
found not to be under warranty according to the
conditions below.

Please note that some of your personal settings,
downloads or other information may be lost when
your Sony Ericsson Product is repaired or replaced.
At present Sony Ericsson may be prevented by
applicable law, other regulation or technical
restrictions from making a backup copy of certain
downloads. Sony Ericsson does not take any
responsibility for any lost information of any kind and
will not reimburse you for any such loss. You should
always make backup copies of all the information
stored on your Sony Ericsson Product such as
downloads, calendar and contacts before handing in
your Sony Ericsson Product for repair or
replacement.

Conditions

1 The warranty is valid only if the original proof of
purchase issued to the original purchaser by an,
for this Product, Sony Ericsson authorized dealer,
specifying the date of purchase and serial
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number**, is presented with the Product to be
repaired or replaced. Sony Ericsson reserves the
right to refuse warranty service if this information
has been removed or changed after the original
purchase of the Product from the dealer.

2 If Sony Ericsson repairs or replaces the Product,
the repaired or replaced Product shall be
warranted for the remaining time of the original
warranty period or for ninety (90) days from the
date of repair, whichever is longer. Repair or
replacement may involve the use of functionally
equivalent reconditioned units. Replaced parts or
components will become the property of
Sony Ericsson.

3 This warranty does not cover any failure of the
Product due to normal wear and tear, or due to
misuse, including but not limited to use in other
than the normal and customary manner, in
accordance with the Sony Ericsson instructions for
use and maintenance of the Product. Nor does this
warranty cover any failure of the Product due to
accident, software or hardware modification or
adjustment, acts of God or damage resulting from
liquid.

A rechargeable battery can be charged and

discharged hundreds of times. However, it will

eventually wear out

— this is not a defect. When the talk-time or standby

time is noticeably shorter, it is time to replace your
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battery. Sony Ericsson recommends that you use

only batteries and chargers approved by

Sony Ericsson.

Minor variations in display brightness and color may

occur between phones. There may be tiny bright or

dark dots on the display. These are called defective
pixels and occur when individual dots have
malfunctioned and cannot be adjusted. Two defective
pixels are deemed acceptable.

Minor variations in camera image appearance may

occur between phones. This is nothing uncommon

and is not regarded as a defective camera module.

4 Since the cellular system on which the Product is
to operate is provided by a carrier independent
from Sony Ericsson, Sony Ericsson will not be
responsible for the operation, availability,
coverage, services or range of that system.

5 This warranty does not cover Product failures
caused by installations, modifications, or repair or
opening of the Product performed by a non-
Sony Ericsson authorized person.

6 The warranty does not cover Product failures
which have been caused by use of accessories or
other peripheral devices which are not
Sony Ericsson branded original accessories
intended for use with the Product.

7 Tampering with any of the seals on the Product
will void the warranty.

Important Information

8 THERE ARE NO EXPRESS WARRANTIES,
WHETHER WRITTEN OR ORAL, OTHER THAN
THIS PRINTED LIMITED WARRANTY. ALL
IMPLIED WARRANTIES, INCLUDING WITHOUT
LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED TO THE
DURATION OF THIS LIMITED WARRANTY. IN
NO EVENT SHALL Sony Ericsson OR ITS
LICENSORS BE LIABLE FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES OF ANY NATURE
WHATSOEVER, INCLUDING BUT NOT LIMITED
TO LOST PROFITS OR COMMERCIAL LOSS;
TO THE FULL EXTENT THOSE DAMAGES CAN
BE DISCLAIMED BY LAW.

Some countries/states do not allow the exclusion or

limitation of incidental or consequential damages, or

limitation of the duration of implied warranties, so the
preceding limitations or exclusions may not apply to
you.

The warranty provided does not affect the

consumer's statutory rights under applicable

legislation in force, nor the consumer’s rights against
the dealer arising from their sales / purchase
contract.

*EUROPEAN UNION (EU)

If you have purchased your Product in an EU country

you can have your Product serviced, under the

conditions set out above, within the warranty period
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in any EU country where an identical Product is sold
by an authorized Sony Ericsson distributor. To find
out if your Product is sold in the EU country you are
in, please call the local Sony Ericsson Call Center.
Please observe that certain services may not be
possible elsewhere than in the country of original
purchase, for example due to the fact that your
Product may have an interior or exterior which is
different from equivalent models sold in other EU
countries. It may not be possible to repair SIM-locked

Products.
** In some countries/regions additional information

is requested. If so, this is clearly shown on the valid

proof of purchase.

FCC Statement

This device complies with Part 15 of the F@

FCC rules. Operation is subject to the

following two conditions: (1) This device may not

cause harmful interference, and (2) This device must

accept any interference received, including

interference that may cause undesired operation.
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Declaration of Conformity

We, Sony Ericsson Mobile Communications AB
of

Nya Vattentornet

S-221 88 Lund, Sweden

declare under our sole responsibility that our product
Sony Ericsson type AAC-1052014-BV

and in combination with our accessories, to which
this declaration relates is in conformity with the
appropriate standards 3GPP TS 51.010-1,

EN 301489-7, EN 300328, EN 301489-17 and EN
60950, following the provisions of, Radio Equipment
and Telecommunication Terminal Equipment
directive 99/5/EC with requirements covering EMC
directive 89/336/EEC, and Low Voltage directive

' C€ 0682

Lund, March 2006

Shoji Nemoto, Head of Product Business Unit
GSM/UMTS

We fulfill the requirements of the R&TTE Directive
(99/5/EC).



Draft for Internal Use Only - PA2

Icons.
Icon Description
Tells you the strength of the GSM
llll- network signal.

GOoH KB ¥ B:

GPRS is available.

You are in a premium charge zone.
Tells you the status of the battery.
You cannot receive any incoming calls.

You have missed an incoming call.

All incoming calls are forwarded to a
defined number.

All signals are off, except the alarm.
The alarm clock has been set and is on.

The timer has been set and is on.

The stopwatch is activated.

Icons.

Description
You have set a reminder for an
appointment.

You have set a reminder for a task.

A profile other than Normal has been
chosen.

The magic word is activated.

Speaker phone is activated.

The card lock or phone lock is on
A secure Internet connection is
established.

You have received a text message.

You have received an email message.

Your phone is receiving an MMS
message.

Your phone is sending an MMS message.

You have received an MMS message.

29
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con

>

AP J I Ox T =

Description

You have received a voice message.

You have received a WAP push message.
The infrared port is on.

Infrared communication is in progress.

Bluetooth is turned on.

Bluetooth headset is connected to your
phone.

Data is being downloaded to the phone.
Data is being uploaded from the phone.
Line 1 is in use for outgoing calls.

Line 2 is in use for outgoing calls.

Ciphering is currently not being provided
by the network.

An ongoing call.
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Icon
L5

Java

I |
e

Description

The media player is running.
A Java™ application is running.

Your movie can be sent using picture
messaging.

Your movie is too large and cannot be sent
using picture messaging.
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Index

A
accept calls 34
account settings, email 52
alarm clock 78
alerts 64
animations 57
answering

calls 21

using voice control 30
answering service 28
appointments 78
ask to save 25
assembling, phone 8
automatic redialing 22

B
battery
charging 8
inserting 8
Bluetooth 73-76
bookmarks
Internet 70

bookmarks, Internet 69
brightness

display 82
business cards 37
buttons 12

C
calculator 82
calendar 78-80
call list 27
call time 35
Call waiting
PTT 44
call waiting 32
caller-specific ringtones 63
calling
from call list 27
from contacts 24
numbers in message 47
using voice dialing 29
calls
accepting 34

Index

answering 21
automatic redialing 22
emergency 22
fixed dialing 35
handling two calls 33
international 22
making 10, 21
making notes during 36
missed 22
putting on hold 32
receiving 10, 21
recording 66
rejecting 21
restricting 34
speed dialing 28
camera 55-57
certificates, Internet security 71
Change from PTT to cellular call 43
charging, battery 8
Cingular Mall 69
code memo 84
codes
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Index

PIN 9
PUK 9
conference calls 33
connectors 12
contacts
adding phone contacts 24
checking memory 26
default contacts 23
groups of 36
synchronizing 72
cookies 71
copying
to/from SmartChip 27

D
date, setting 78
declaration of conformity 98
directing sound 76
display
brightness 82

E
email
using 52-54
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F
fixed dialing 35

G
games 68
groups 36

H

handsfree 75, 76

help texts, in phone 16
hiding number 36

Hit Picks 62

|

icons 99

IM 54

infrared port 77

instant messaging See messages
instant 54

international calls 22

Internet
bookmarks 70
cookies 70
security 71-72
settings 68

J
Java™, settings 71

K

key sound 64

keys 12

keys and navigation 14

L
language

changing 16

in phone 16, 86
letters

entering 17-18
light effects 19, 24, 64
locks

SmartChip 83
long messages 48

M

magic word 30
main menu 14
Make a PTT call 42
media player 59-62
melodies 63—64
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message alert 64
messages
email 52
picture 51
text 46
voice 51
microphone, turning off/on 21
missed calls 22
MMS See 49
MMS See picture messages 51
multitap text input
entering 17
music, playing 59
MusicDJ™ 64
My Stuff 18

N
navigating menus 14
networks, selecting 20
night mode 56
notepad 36
notes 8081
number

hiding 36

my own 34

o
on if silent 64

P
passcodes

Bluetooth 74

code memo 84
passwords, Internet 71
phone language 16, 86
phone lock 84
phone overview 12
PhotoDJ™ 58
picture messages 4951
picture sizes 56
pictures 57-58

edit 58

screen saver 57

wallpaper 57
PIN code

changing 83

entering 10
profiles 81

Index

PTT 37

add contact 41

add group 41

auto keylock 38
availability 46

available 39, 40

call history 44

call me alert 45

call waiting 44

change to a cellular call 43
change your name 46
confirm on 38

contact alert 46

contact search 45

delete contacts 45

do not disturb 39, 40
dynamic group 45

edit contact 42

edit contact name 45

edit group 42

functions 44

group contact list options 45
how a PTT call works 43
icons 39
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Index

individulal contact list
options 45
initialize service 37
invitation in progress 39, 40
leave group 45
make a call 42
manage members 45
message indicator 39
nickname 46
quick group calls 43
receive a call 42
settings 46
silent 39, 40
tips 38
tones 43
unavailable 39, 40
vibrate 39, 40
voice message 44, 45
PUK 83
Push to Talk (PTT) 37

R
Receive a PTT call 42

recording
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calls 66

sounds 66

video clips 56

voice commands 29-31
redialing 22
remote control 76
resetting phone 88
restricted dialing 34
ringtones 63—64
roaming 20

S
safety guidelines 98
saving
from picture messages 51
from text messages 48
screen 82
screen saver 57
security
code memo 84
Internet 71-72
SmartChip lock 83
sending
appointments 80

business cards 37
contacts 26
melodies and ringtones 65
notes 81
pictures 58
tasks 80
themes 67
settings for Java™ 71
setup wizard 10
shortcuts 16
SmartChip
copying to/from 27
inserting 8
lock 83
unblocking 83
SmartChip contacts 23
SmartChip numbers 25
SMS See text messages 46
SOS See emergency numbers 22
sound
directing 76
transferring 76
sound recorder 66
speaker volume 21
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special needs 90
speed dialing 28
standby screen 14
startup screen 57, 82
status bar 14
stopwatch 81
streaming media 62
Style-Up 10, 12
synchronizing 72-73

T
T9™ Text Input
entering letters 18
tasks 80
templates
for picture messages 51
for text messages 48
text messages 4649
themes 67
time, setting 78
timer 81
transferring sound 76
TTY 90
Phone Number 90

turning on/off

Bluetooth 74

infrared port 77

key sound 64

phone 10

phone lock 84

ringtones, melodies 63

SmartChip lock protection 84
two voice lines 33

U
unblocking
PIN 9
SmartChip 83
\'

vibrating alert 64
video clips 59

video recorder 55-57
VideoDJ™ 65

voice answering 30-31
voice control 28-31
voice dialing 29-30
voice messages 51

Index

voicemail 28

volume
changing 21
setting ringtone 63
vibrating alert 64

w
wallpaper 57
WAP See Internet 68
wizard
setup 10
writing
using multitap input 17
using T9™ Text Input 18
writing languages 17

Z
zoom 56
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